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Introduction

SWEET SIXTEEN is a sequencer program that allows you to record, edit and playback all types of MIDI 
events and store them to disk. The resolution of the sequencer is 192 PPQN (ticks per quarter note) and 
thanks to the multitasking capability you can use almost every command while SWEET SIXTEEN is 
running.

You will need a PC-compatible computer, minimum 386SX, 16 MHz, with at least 2 Megabytes of RAM 
and Windows 3.1 or later. You will also need some kind of sound source, either a soundcard with MIDI 
capabilities or a MIDI interface and an external synthesiser.

Installing

Setup

General Handling

First Steps



Installing

In order to run SWEET SIXTEEN you first have to install it onto your hard-disk using the installation 
program on the program disk.

Installing procedure:
1. Launch Windows.
2. Insert the floppy disk in Drive A or B.
3. From the Program Manager File menu, choose "RUN".
4. A dialogue box will appear. In the "Command Line" field enter...    A:INSTALL or B:INSTALL
5. The installation program on the floppy disk will run. Follow the on screen prompts to complete the 
installation.

If any changes have been made to the program, you will be informed by a "Read me" text that will appear 
in a window at this point.

The installation program creates a Program Manager group called "SWEET SIXTEEN" and Program 
Manager items (icons) for the SWEET SIXTEEN program, this help file, and a couple of demo songs.

SWEET SIXTEEN is designed to run with the Multimedia Extensions under Microsoft Windows (3.1 and 
upwards) which means you also have to make sure you have installed a MIDI driver for the interface or 
soundcard you are going to use (see the instructions for your interface).

To run SWEET SIXTEEN, double-click its icon in the Windows Program Manager.



MIDI Setup
When starting SWEET SIXTEEN for the first time you will be told to set up your MIDI interface. Choose 
the MIDI/Memory Setup Dialogue from the Options menu.

Here you select which MIDI In and MIDI Out ports you want use by using the drop-down lists (combo 
boxes).

All the MIDI ports that are available on your system will appear in the list boxes along with a "No device" 
choice. The Output port lists should also have an option for the MIDI Mapper. See your Multimedia 
Extensions documentation for details on using the MIDI Mapper.

To make a port selection, click on the arrow button on the right of the combo box and a list of all available 
selections will appear. Click on the selection that you want. The "No device" choice is useful for freeing up
a port so that it can be used by another application.

Memory Setup
Since Windows is a multitasking environment, many programs may share the available memory. SWEET 
SIXTEEN allocates the requested memory amount when it starts. This may seem as a drawback 
comparing other programs, but it makes the allocation of memory reliable and very fast.

In the MIDI/Memory Setup Dialogue you choose the number of MIDI events you will need. If you at any 
time are running out of memory you will have to increase the number of MIDI events, save your work and 
restart SWEET SIXTEEN. Try to avoid allocating more memory than you really need since this will slow 
down the overall performance of your system (Windows).



General Handling

The main screen in SWEET SIXTEEN is made up of three areas within a window. To the right the Pattern
Box with the 24 tracks. To the left the Arrange Box with the settings for Song Mode and below, the 
Control Box with the transport controls and some global settings.

A word icon is sometimes used for smaller boxes/symbols that reacts to mouse clicks.

You can control SWEET SIXTEEN entirely with the mouse.

Here's an explanation of terms used for the mouse.

'Mouse Click' or 'Click'
Click the mouse button with the mouse cursor over the specified event.

Double Click
As for single clicks but two clicks close together.
You may double click a value and enter the desired value with the computer keyboard.
This feature is only available if the Allow Double Clicks in the Flags Menu is ticked.

Click and Drag
As for single clicks but hold down the left mouse button and drag the selected item to a new position on 
the screen.

Scroll
'Left click' on the specified object and the value will increase one step, 'Right Click' and the value will 
decrease one step. If you keep either button held down the value will start increase/decrease as long as 
the button is held. This is called scrolling. Adding the other button during scrolling will speed up the 
process.

NOTE: In the Overall Settings feature you may swap the function of the right and left Mouse Buttons. i.e.
Right to increase and Left to decrease,    Swap Mousebuttons.



First Steps
This is a short introduction to SWEET SIXTEEN and it assumes that you have a working knowledge of 
your PC.

Basics

Barcounters

Transportation

The First Recording



Basics

MIDI Connections
1. Connect the MIDI OUT from your keyboard to the MIDI IN of your MIDI interface.
2. Connect the MIDI IN of your keyboard to the MIDI OUT of your MIDI interface.
3. If you have an additional module, connect it's MIDI IN to MIDI THRO of your keyboard.
4. Set your synthesizer(s) to receive/transmit on your chosen MIDI channels. If possible, set the 
synthesizer to Local Off which will disconnect the keyboard from the sound source in your synthesizer 
and thereby avoiding the voices being triggered twice. If you have an old synthesizer without Local On/Off
(e.g. an old DX-7), you must disable the MIDI Thru function on the receive channel of your synthesizer. 
Use MIDI Thru Off in Overall Settings.

Most manufacturers provide excellent diagrams and information about setting up their particular 
equipment. Refer to your synthesizer USER MANUAL as it will help you to get things right first time.

Running the program
Double click the SWEET SIXTEEN icon in the Program Manager. You will see the main screen of SWEET
SIXTEEN and in the right half of the screen there is a large box called the Pattern Box.

The Main Screen
The Pattern Box is divided into twenty-four smaller sections, the 24 tracks. Clicking in the centre of a track
allows you to select that particular track.

Every track has a MIDI channel (1- 16) displayed to the far right. The events on a track will be sent out on 
this channel and if its the selected track, this channel will be the MIDI Thru channel.

Play the keyboard! 
If you don't hear anything, check that your synthesizer is receiving on this channel. If this is OK and you 
still don't hear anything, check your MIDI connections.

Storing MIDI Events
When a MIDI event arrives at the MIDI In port, it is stored in the computers memory together with time 
information. To organise messages that belong to each other they are stored together. We will call this a 
"track". A track can hold any number of MIDI events, be of any length and store MIDI events on one or 
several MIDI channels.

To organise it further, we can record up to twenty-four tracks. We can now call this a "pattern". SWEET 
SIXTEEN has 17 patterns.
The first sixteen patterns can be assembled in any order and length with the help of an "Arrangelist". 
One pattern might be the intro, another the verse, a third a chorus and so on.

Pattern 17 has a special function. It will run in parallel alongside the other patterns in the Arrangelist. This
means that SWEET SIXTEEN is actually a 48 track sequencer.





Barcounters
Now let's look at the Barcounter, how it is displayed and what it means. In SWEET SIXTEEN all time and 
length indications are displayed as follows:

The first column
Displays the bar number. The first bar is called bar 1, the previous bar, bar 0 and the bar before that, bar -
1.

The second column
Displays the beats and the value shown depends on the meter. In 4/4 this column shows what quarter 
note is currently playing, in 7/8 what eighth note is currently playing.

The third column
Displays the division of the beat. All kinds of music have some kind of subdivision of the beat (pulse). 
Musicians often call it groove. In a "jazzgroove" every beat can be divided in three parts (12 eight note 
triplets in 4/4). In a "funk groove" the beat can be divided in four parts (16 sixteenth notes in 4/4) and a 
"hip hop" groove in six parts (24 sixteenth note triplets). In SWEET SIXTEEN this subdivision of the beat
is called the "groove" and is displayed to the right of the Time Signature value. The groove value does 
not in any way affect the way the music sounds, only how it is displayed.

The fourth column
Displays the clockticks (clockpulses), the smallest time unit in SWEET SIXTEEN. You can think of it as a 
subdivision of the third column. If you choose groove value 16 there will be 48 clockticks per sixteenth 
note. The number of clockticks per quarternote (PPQ or PPQN) is usually used to indicate how precisely 
a sequencer is able to reproduce a note ie. it's resolution. The PPQ value of SWEET SIXTEEN is 192 
which is a very high value.

Note: In the Options Menu there is an item called Simple Bardisplay. With this item ticked all, all 
barcounters will display the position as Bars, Beats and Ticks instead of Bars, Beats, Groove and Ticks.
This of course is optional.

The Barcounter in use
To the right in the "Control Box" you will see the "Main Bar Counter". It gives the current song position in 
bars, beats, subdivisions of the beat and clockticks (clockpulses). You can click and scroll the value with 
the mouse, during playback and recording. You may also use [+] and [-] on the computer keypad.

You can store and recall four bar counter positions with the help of the function keys [F1]...[F4]. Press 
[Shift] + [F1]...[F4] to store your settings.

Below the "Main Bar Counter" there are boxes for the "Time Signature" and the "Groove" value. If your 
song doesn't change time signature you may enter the time signature here. But, if your music does 
change time signature you will have to activate the "Time Signature Box" in the Control Box, or press [W].



Transportation
To control the transportation SWEET SIXTEEN uses a number of icons situated at the bottom of the 
screen: Play, Stop, Cont, Record, Fast Forward and Fast Rewind. These controls work in the same way 
as a normal tape recorder.

The "Play" Icon
([0] On the numerical keyboard).
This icon activates playback of the sequencer. In "Pattern Mode" the sequencer starts from bar 1 (1 1 1 
1). In "Song Mode" the sequencer starts from the beginning of the current arrange list position. In "Cycle 
Mode" the sequencer starts from the left locator position.

The "Stop" Icon 
([ENTER] On the numerical keyboard).
This stops the sequencer. If the sequencer was in "Record Mode", the recording is ended and the 
recorded data will be stored in the current track. If the sequencer is already stopped, the "Main Bar 
Counter" will be reset to Bar 1 (1 1 1 1). At the same time some MIDI events like, All Notes Off, Reset 
Controller etc. will be sent out provided the menu item "Flags / Reset On Stop" is ticked.

The "Cont" (Pause/Continue) Icon
([ . ] On the numerical keyboard).
If the sequencer is stopped it will start playing from the current position of the "Main Bar Counter". If the 
sequencer is playing it will stop. If the sequencer is in "Record Mode" it will remain in record mode. This 
makes it possible to forward or rewind the program (click the "Main Bar Counter", use the "Fast Forward" 
or "Fast Rewind" icons or use the [+] or [-] buttons on the keyboard) and then continue the recording with 
a new "Pause/Cont" command.

The "Fast Forward" and "Fast Rewind" icons
([+] and [-] On the numerical keyboard).
This as its name suggests, Fast Forwards and Rewinds the main bar counter.

Recording Modes
SWEET SIXTEEN has two different record modes, "Replace" and "Overdub".

A left click on the "Record" icon ([*] on the numerical keyboard) starts a recording in "Replace Mode" (any 
previous recording on the track will be deleted).
A right click on the "Record" icon ([/] on the numerical keyboard) starts a recording in "Overdub Mode" 
and any previous recording on the track will be overdubbed (useful for creating drum tracks). A one bar 
count-in begins, during which it is possible to start a recording.

In "Pattern Mode" the recording will start from Bar 1 (1 1 1 1).
In "Song Mode" it will start from the start bar of the current arrange list position.



In "Cycle Mode" the recording starts from the left locator position.

Cycle Mode
"Cycle Mode" is activated by 'clicking' on the Cycle Box, keycommand [C]. The music will, when it 
reaches the "Right Locator" position, jump to the "Left Locator" position and continue playing or recording.

Drop In/Out
At any time you may toggle between record and play mode with the "Spacebar" key or clicking the 
"Drop In/Out" icon. When entering record mode this way, the notes played will be added to what is 
already on the track (overdubbed). If you hold down the "Shift" key while pressing the "Spacebar" key, the
new recording will replace the old one (replace mode).



The First Recording
Click on the "Record" icon and you will hear a one bar count-in. (If not, check the MIDI Click settings in 
Overall Settings). The one bar count-in starts the recording.
Note: You may change to a two bar count-in with 2 Bar Count In in the Flags Menu. 
 
Play something on your keyboard in time with the metronome. When finished 'Click' on the "Stop" icon. 
The sequencer stops and you'll see 'recorded' on the track. 'Click' on the "Play" icon and the sequencer 
will start playing from bar one and you will hear what you have just played.

If you don't hear anything, check the connections, the synthesizer etc.
 
When all is satisfactory it is a good idea to 'Name' the newly recorded track with its designated 'Voice'. If 
say you recorded a piano track then make sure your recorded track is highlighted (inverse video), press 
[ESC], type in "PIANO" then either press [RETURN] or 'click' the OK box. Select another track and 
continue in the same manner.

If you are not happy with a track, click and drag the track to the left of the Pattern Box, release the button 
and it's deleted.

You may also start to re-record on a track without first deleting it. This also deletes previous data.

Do some experimenting
Now try to change some of the track parameters. A Loop value other than zero will loop around the first 
beats according to the loop value. Quantize will tighten up the music and you can set various Transpose, 
Velocity and Delay values. All the mentioned track parameters are playback parameters i.e. they affect 
the music as it is played back without changing the data in the memory.
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Tracks
We will now look more in detail how a track is organized and can be 'Fine Tuned' after recording it.

Every track has a number of parameters (values) that decide how the MIDI events on the track will sound.
Whenever a MIDI event arrives at the MIDI In port it will also be sent to one of the MIDI Out ports. This is 
called MIDI Thru and the current track parameters will decide how it will sound.

It is possible to disable the MIDI Thru function. Click in the MIDI Thru activity area down in the right corner
of the screen.

The beauty of the track parameters is that they are "non destructive". This means that it is possible to 
change the values any way you want and still be able to return to the original settings. This is because the
track parameters do not change the events in memory of the computer. The changes are made in "real 
time" when the MIDI events are sent out to the MIDI output. This means you cannot see the effect of the 
track parameters in Edit Mode. To do so, (thus making permanent changes) you have to Freeze Track 
Parameters in the Extra Menu. The exception is the quantization which will be seen in the editors (it is 
still possible to go back to the unquantized values). The corresponding function is Freeze Quantize which
will freeze the time position of the events.

Since you have 24 tracks you will have to choose one of them. Either Click the area where you name the 
track (between the transpose and loop values) or press [Arrow up] / [Arrow down] to choose your track. 
The chosen track area is displayed in inverse video. Double clicking in the same area, or pressing [Esc], 
opens up a dialogue box where you may enter a name for the track, then by either pressing [RETURN] or 
'clicking' the OK box the track is now named. This is also the way to create a track without recording.

To copy, delete or merge a track, click on a track and drag it:
1. To the left to ERASE it.
2. Over an occupied track to MERGE it.
3. To a blank track to COPY it.

We will now look at all the parameters of a track.

Track Number
To the far left you see the track number.

Mute
The next column is the mute column. Clicking in this area mutes the track. This area also shows small 
beams that imitates a recording desks "level meters". The length of the beam corresponds to the velocity 
value of the note. Mute does not affect the MIDI Thru function.



Transpose
The next column is the transpose column. With this you can transpose the track, plus or minus 64 
semitones. Holding down the [Shift] key while clicking, transposes 12 semitones (an octave). Transpose 
affects the MIDI Thru function.

Loop
This column to the left of the track name area is the loop column. A loop means that a part of a track, 
beginning from bar one of the current pattern, will be repeated. The value determines the length of the 
loop in beats (depends on the time signature). If the value entered is not evenly divisible with the beat-
value of the current time signature, an exclamation mark is shown. Loop does not affect the MIDI Thru 
function.

Delay
The next column is the (Del)ay column. This parameter moves all events on a track forward or backward. 
The value is in clock ticks. A positive value will play the events later (delay), a negative value earlier 
(advance). This parameter is often used to compensate for the difference in response time between 
different synthesizers. If you move the track earlier, events that have a time position of 1 1 1 1 will be 
moved before bar 1. This means you will not hear them (as Sweet Sixteen ALWAYS starts from 1 1 1 1). 
You must therefore start the current pattern somewhat earlier. In Song Mode you use the Pre Start 
function. Delay does not affect the MIDI Thru function.

Compression
The next column is the (Comp)ression column. This parameter affects the velocity value in such a way 
that the difference between the high and low value is evened out. All velocity values are moved towards 
64, closer the higher compression value you choose.

A compression value of 4 will give all notes a velocity value very near 64. Since notes with high velocity 
value are decreased, you may have to increase the general velocity value. Compression affects the MIDI 
Thru function.

Velocity
The (Vel)ocity value of a note depends on how hard or soft the key was struck. The track parameter 
Velocity adds to or subtracts from the velocity values the notes already have (the values you see in Edit 
Mode). How it affects the sound depends on the sound of your synthesizer. A positive value will usually 
give a louder and/or a brighter sound and vice versa. Max velocity value is 127, Min velocity 0. Velocity 
affects the MIDI Thru function.



Quantize
The next column is the Quantize column. When you click on the 'QUA' and keep the button down you will 
see a "pop up" menu with a number of numbered boxes. When you move the mouse (the button still 
down) the different boxes become black (chosen value of quantization). When you release the button, 
the track will be quantized according to the value in the box. If you choose "NO", the track will be 
dequantized (return to it's original unquantized value). If you release the button while the mouse pointer is
outside the "pop up" menu, no box is chosen and no action will be performed. Quantize does not affect 
the MIDI Thru function.

Channel
The last column is in fact two columns. The first to choose MIDI port (A or B) and the second to choose 
MIDI channel. As well as the digits 1-24 which shows on which MIDI channel the Track will be sent out on 
there is also the symbol "--". This shows that the Track can be sent out on several MIDI channels. This 
means you can have more than one MIDI channel on each track. These settings affects the MIDI Thru 
Function.

Solo Track
If you click on the "Solo" icon, press [S], all the tracks except the current will be silent. This simulates the 
solo function of a mixer in a recording studio. You may switch tracks while in solo mode.

More Patterns
Choose another pattern and continue recording as before. When you have recorded all the parts 
(patterns) of your song, it's time to arrange them in the order you would like to hear them. To the left of the
Pattern Box you'll see another box, the Arrange Box. Here you can form your arrangement by arranging 
the order and length of your patterns. Click on the "Song/Pattern Mode" icon in the top of the Arrange Box
to enter Song Mode.
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The Arrange Box

To the left of the Pattern Box you will see another box called the Arrange Box. Here you can arrange your 
patterns (1-16) and make various settings that affect the playback of your song when in Song Mode.

Clicking in the top of the Arrange Box switches between Song and Pattern Mode,[A].

These parameters function in the same way as the track parameters i.e. real-time parameters which do 
not change the MIDI events in memory, they just affect the events passing out thru the MIDI port to your 
sound source.

In Song Mode Pattern 17 runs parallel to the arrange list of Patterns 1-16.

The arrange box contains a list of 32 entries of which you can see 9 at a time. The current entry is the 
second from the top (displayed in inverse video). The idea of the arrange list is, (after you have recorded 
the different parts of the song: intro, verse, chorus, bridge etc.), for you to arrange them in any desired 
order.

You scroll through the arrange list with the arrow icons in the bottom of the Arrange Box, or press [Shift] + 
[Up Arrow]/[Down Arrow]. If you 'Click' with the right mouse button, the Left and Right Locators will be 
loaded with the start and end values of the current arrange entry. You can also use the right window scroll
bar to scroll through the arrange list.

We will now explain the different settings for each entry in the arrange list.



Position Start Bar
The left column displays the starting bar for the arrange entry in question. You can change this value by 
'clicking' but you normally do not have to since changing the length of the preceding arrange entries 
automatically changes the start position of all subsequent entries.



Pattern Number
The middle column displays the pattern number and by 'Clicking' you can change this value. Possible 
settings are 1-16. Pattern 17 can not be entered since it runs parallel to the arrange list.



Position Name
The rightmost column is the name column. To enter a name, double 'click'. If you enter the name STOP 
the sequencer will stop when it reaches this arrange entry.

Below the arrange list you will see a number of boxes. The settings you make here apply to the current 
arrange list entry (the black one). To enter values for a particular arrange list entry you will have to make it
the current one (the one you see displayed in inverse video).



Position Length
Here you enter the length of the arrange list entry. It can be any length so the same pattern may appear in
different arrange entries with different lengths. If you change the length of an arrange list entry, the start 
position of all subsequent entries will change accordingly.



Position Track Mute
Between the Arrange Box and The Pattern Box there is a column with an icon named M at the top and 24 
small boxes displaying 1-24 underneath. Here you choose (by clicking any of the boxes) which tracks 
should be temporarily muted in the current Arrange Entry. A box displayed in inverse video indicates a 
muted track.



Position Transpose
Each entry in the arrange list may have a transpose value. With value 0 the current pattern sounds the 
same as in Pattern Mode. With another value the pattern will be transposed up or down. This affects all 
tracks in a pattern (including the drum tracks). It is therefore possible to disable the transposition of the 
MIDI channel you use for the drums. "Overall Settings" in the Option Menu contains facilities for just 
this, "Disable Transpose".



Pre Start
With SWEET SIXTEEN you may record during the count in i.e. before bar number one. This means, that if
one of your patterns has an upbeat, you begin to play during the count in. The upbeat will then belong to 
the pattern. When you choose a pattern in the arrange list this pattern will start to play from bar one of the
current arrange list entry. But, since your upbeat is before bar 1, you will not hear it. That's when Pre Start
comes into the picture.
The Pre Start value you enter determines how much before bar 1 the current arrange entry will begin. 
This also means that the previous pattern/arrange entry will be shortened with the same value.

Example 1
The chorus in a song starts with a sixteenth note upbeat. When the program is in Pattern Mode and you 
press the Play icon, the music starts from bar 1. You will not hear the upbeat since it is before bar 1. 
Switch to Song Mode and enter a Pre Start value of one sixteenth note (0 0 1 0) in all arrange list entries 
that contain this pattern. This pattern will start playing a sixteenth note earlier and you will hear the 
upbeat.

Example 2
Suppose you have, with the help of track parameter Delay, speeded up a "laid back" string sound with 
value -5. This track will play 5 clock ticks ahead of the other tracks. If the track has a note at 1 1 1 1, it will
be before bar 1 at the pattern change. You must give this arrange entry a Pre Start value of at least    0 0 0
5 (five clock ticks) so the notes before bar 1 will sound.

Example 3
When SWEET SIXTEEN changes from one arrange entry to another, the program checks if any notes are
still sounding. If so, each note is switched off with a Note Off message. If the next pattern/arrange entry 
starts with a lot of notes at bar 1, there will be a lot of MIDI events to output at the same time. This will 
make some synthesizers 'Hiccup' and either play the notes late, or not at all. If this is the case you can 
make the next arrange entry start a little earlier by giving that arrange entry a Pre Start value of 5-10 clock
ticks.
This makes the previous entry end that much earlier and stop any 'sounding' notes before sending out 
new ones.



Delete
Click on the "Del(ete)" icon, [Delete], will delete the current arrange entry and all the following arrange 
entries will be moved accordingly.



Insert
A click on the "Ins(ert)" icon, [Insert], will move all arrange entries (from the current and on) a step 
forward. You can now enter new values in the current entry.



A small re-cap of how to arrange Patterns
Suppose your song starts with pattern 1 (an INTRO of 4 bars ). Firstly enter PATTERN 1 in the first 
arrange entry with a length of 4 bars. In the next entry you may want to have PATTERN 2 (say a verse of 
8 bars ). PLUS, a Solo over the verse later in the song so compose your PATTERN 2 to INCLUDE this 
Solo. Click on the right arrow icon in the bottom of the Arrange Box to get the second arrange entry to be
the current one (the second arrange line from the top and displayed in inverse video). Set this to 
PATTERN 2 with a length of 8 bars. But, when this is played 1st time round you don't want the solo to play
so you mute this track by clicking one of the small boxes displaying digits 1-24 between the Arrange Box 
and the Pattern Box. This will mute the desired track in this arrange entry only. In the 3rd arrange entry 
you may want to have Pattern 3 say a Chorus of 8 bars. Repeat the above procedure. In the 4th arrange 
entry you may want Pattern 2 but this time you want the SOLO track to play. You un-mute this track by 
clicking the small box where you 'Muted' the track before. You may also
transpose a whole pattern in an arrange entry. In the Overall Settings you may disable the transposition 
of the drum Track/Channel. This method of recording makes it so easy to build up a whole song. For 
example:

You may have:

PATTERN 1. (Intro)
PATTERN 2. (Verse inc. Solo)
PATTERN 3. (Chorus)
PATTERN 4. (ending)

You can now make your arrange list to read:

PATTERN 1. 4 bars
PATTERN 2. 8 bars    Solo track Muted
PATTERN 2. 8 bars    Solo track Muted
PATTERN 3. 8 bars
PATTERN 2. 8 bars    Solo track ON
PATTERN 3. 8 bars
PATTERN 3. 8 bars
PATTERN 4. 4 bars

Now you have INTRO - VERSE - VERSE - CHORUS - SOLO - CHORUS - CHORUS - ENDING and have
constructed a whole song from just 4 PATTERNS.



Pattern 17 - '24' New Tracks
Pattern 17 has a special field of application. In Pattern Mode it works exactly as the other 16 patterns. In 
Song Mode however, Pattern 17 cannot be part of the arrange list but runs parallel to it. This means you 
have another 24 tracks to use.

Example 1
A solo starts of in one arrange entry, continues in the next and ends in the third.

Example 2
A percussion track, starting in bar 1, plays a two bar rhythm that is looped throughout the whole song.

Example 3
A track with all drum fills can be recorded in one shot while the whole song is playing.

Example 4
A track with all program changes and volume (controller 7) events.

The possibilities are endless. It is advisable to hold back on all recordings in Pattern 17 until the structure 
of the song is finished. If you change a pattern number, pattern length or transpose value in the arrange 
list, you will probably have to change things in Pattern 17 as well (move a track forward/backward with 
Push Track or use Delete/Insert Measures, transpose a part of a track with Modify Track etc). Thus, as 
soon as you change from Pattern Mode to Song Mode, PATTERN 17 is activated as a parallel pattern.
Sometimes you may not want to hear it: click on the "M" icon to the right of the "Pattern/Song Mode" icon 
and Pattern 17 will be muted.

If you choose Pattern 17, this will be the current pattern until you choose another one. In the arrange list 
you can see what other pattern is playing. In Song Mode, recording in pattern 17 will start from the first 
bar of the current arrange list entry.



Recording in Song Mode
Recording in Song Mode works in the same way as in Pattern Mode. If you have anything recorded in 
Pattern 17, recording in Song Mode is necessary. This is the only way to be able to listen to both Pattern 
17 and the current pattern in the arrange list.

If you choose Pattern 17, recording will take place there. Otherwise recording will take place in the pattern
of the current arrange entry.

As always, it is possible to record during the count in. However, even if the arrange list jumps to the next 
entry, recording will still only take place in the pattern where it began (you can only record in one pattern 
at the time). If you want to record something that stretches over more than one pattern/arrange entry, this 
must take place in pattern 17.

Cycle Recording is also possible in Song Mode. If you enter values that are beyond the current arrange 
list entry, you will get a warning. If you still want to proceed, you can do so.



Cycle Recording
With the help of the Left and Right Locators, you can enter two positions that the program will cycle 
between. This is called Cycle Mode. When the right position is reached, the sequencer jumps back to the
left locator position without leaving the recording mode. In every operation of the cycle, any notes played 
will be added to existing notes and therefore can be called Overdub Record.

If you enter a quantize value, the quantization will be executed after each round without interrupting the 
timing of the music. This is real multitasking!

Whilst recording you may, by pressing [B], erase each overdub, beginning with the last one recorded. 
SWEET SIXTEEN distinguishes between the different rounds by assigning each round to a different MIDI 
channel. Track parameter Channel will still decide what MIDI channel it will be assigned to. This makes it 
easy, after the recording is finished, to delete a round with the Keep/Delete functions.

Whilst not in Cycle Mode, recordings will always start from the start-bar of the current arrange entry. If you
want to start the recording from another position, you can activate Cycle Mode and enter the position from
where you want the recording to start from into the left locator. The right locator can have a smaller value 
(or a much larger) so the program doesn't instantly jump back to the left locator position.



Auto-Punch In/Out
Clicking the Punch button, [P], will make SWEET SIXTEEN enter record mode at the Left locator position 
and drop out of record mode at the Right locator position. The section of the track between the two 
positions will be erased (replace mode). 

Pressing the "Space bar" key or 'clicking' the "Drop In/Out" icon, will toggle between record and play 
mode (also when stopped). When entering record mode this way, the notes played will be added to what 
is already on the track (overdubbed). If you hold down the "Shift" key while pressing the "Space bar" key, 
the new recording will replace the old one.

Don't forget that you can store and recall up to four locator positions with the help of the function keys 
[F5]...F[8].

Before you turn off the computer, SAVE YOUR SONG (don't save anything on your program disk). There 
is a separate section on Saving/Loading discs but for now, activate the File Menu. From the Drop-Down 
menus select Save Song. When the file-box appears give the song a name and 'click' OK. Your song is 
now saved to disc.

Did you play any wrong notes? SWEET SIXTEEN has a lot of very powerful functions to edit, process and
modify your music. These will be explained in the Edit section but before we look at this section, lets run 
through the different Menus so you will be able to see the capabilities of SWEET SIXTEEN. Here we go!



The Undo Function
The Undo function allows you to cancel the latest change you have made to a track. If you, by mistake, 
delete a track, record over a track etc, you can get the track back as it was before the change by 'clicking' 
the "Undo" icon, Keycommand [Alt] + [Backspace]. Another useful feature is that you can also toggle 
between the old and new versions for direct comparison.
The Undo function will not work if the alteration involves more than one track, eg "Mixdown 24 Tracks", 
"Track Merge" etc.



Synchronization
Synchronization means that you can lock together two (or more) devices so that they follow each other 
exactly. One device will be the "Master", i.e. lead the process and the other will be the "Slave". 
Synchronization in SWEET SIXTEEN is done with MIDI Clock messages that are sent from the "Master" 
to the "Slave".

In the Options Menu you'll see an item labelled "Synchronization". It has two modes, Internal and 
External Sync Mode.

In Internal Sync Mode SWEET SIXTEEN will be the master. For SWEET SIXTEEN to send out sync 
pulses you must activate "Clock Out" in the Flags menu. SWEET SIXTEEN is now able to control other 
MIDI devices, e.g. Drum Machines, Data Filers, MIDI File Players. It will also send the following MIDI 
messages: Start, Stop and Continue. However if your main purpose is to access the sounds in the drum 
machine, it's better to record the drum notes as MIDI events than synchronize the two devices together.

In External Sync Mode SWEET SIXTEEN will be the slave and follow the "master". SWEET SIXTEEN will
respond to the following MIDI messages: Start, Stop and Continue messages, MIDI Clock pulses that 
control the tempo and Song Position Pointers that tell the exact position to start from. In spite of the low 
resolution of MIDI Clock pulses (24 PPQ) SWEET SIXTEEN is able to keep it's own high resolution (192 
PPQ) even in External Sync Mode, by using something called "Interpolation between Clock Pulses".

To be able to synchronize SWEET SIXTEEN to a tape recorder you'll need a device called a 
"Synchronizer". This device is able to translate MIDI information into analogue signals that can be 
recorded on tape. One example of such a device is the JLCooper PPS-1. With this device you can control
SWEET SIXTEEN (slave) from a tape recorder (master).

It's also possible to record in External Sync Mode. Just click on the "Drop In/Out" icon to enter Record 
Mode. SWEET SIXTEEN will start the recording when it gets a Start or Continue command.



System Exclusive

System Exclusive (SysEx) are special types of MIDI events that are unique to each type of synthesizer. 
This means that SysEx from one synthesizer cannot be understood by another.

A SysEx message can be of any length and consequently may take a long time to transmit. This means 
you should have your SysEx events before the music starts and not inside your songs.

With SWEET SIXTEEN you have the possibility to record and playback SysEx messages. You may 
"dump" sounds, patches or the whole memory of your synthesizers into SWEET SIXTEEN (please read 
your synthesizer manual for more info on Bulk Dump).

It is possible to edit short SysEx messages in the Event Editor.

If your main purpose is to recall desired voice numbers (patches), you should use program change events
or the Mixer, not SysEx.

To record SysEx into SWEET SIXTEEN, do like this:
1. Check that SWEET SIXTEEN does not filter out incoming Sys Ex (Input Filter in Overall Settings).
2. Click on the "Record" icon.
3. Send SysEx from your synthesizer - read your synthesizer manual.
4. Arrange for the SysEx events to be read before the start of your song, or save this SysEx as a separate
track.

To transmit SysEx back to your Synthesizer, do like this:
1. Load your song or SysEx track into SWEET SIXTEEN.
2. Enable SysEx receive on your synthesizer.
3. Start playback.



Flags Menu
All items in this menu are either ON or OFF. If there is no 'Tick against the flag, it is OFF.
To switch it on just 'Click' the mouse button. You immediately leave the menu but on re-entering you will 
see it 'Ticked' meaning ON. Similarly if the flag is ON (ticked) by 'Clicking the mouse it will be 'Unticked' 
i.e. OFF.

MIDI Click

Click Always

2 Bar Count In

Clock SPP/Out

Reset On Stop

Chase Events

Actual Position

Simple Bardisplay

Show Real Time Clock

Allow Double Clicks



Click Always

Click Always means that the metronome is activated in PLAYBACK and RECORD.



MIDI Click

MIDI Click means that the metronome is sent out via MIDI. (Choose a suitable click note, port etc in 
Overall Settings).



Actual Position

When SWEET SIXTEEN is in Song Mode and you activate Actual Position, the time positions will be 
shown relative to the beginning of the arrange list. When Actual Position is off, time positions are shown 
relative to the start of the current pattern.

Example: You have a pattern where the first note starts at 1 1 1 1. If the pattern is placed in an arrange list
entry that starts at bar 33 (33 1 1 1), and 'Actual Position' is activated, the time position of the event will 
be displayed as 33 1 1 1. Otherwise it will be displayed as 1 1 1 1.



Clock SPP/Out

If Clock Out    is activated, SWEET SIXTEEN will send out Song Position Pointers (SPP), MIDI Clock, 
Start, Stop and Continue messages at port A. This allows you to synchronise SWEET SIXTEEN to other 
MIDI equipment.



Reset On Stop

If this is activated, SWEET SIXTEEN automatically resets Pitch Bend, Modulation and Aftertouch for all 
tracks. It also sends out Sustain Off and All Notes Off messages.
When this is turned on, it might reset things you don't want to be reset. In most cases you don't need it 
activated since SWEET SIXTEEN keeps track of which notes that needs to be turned off and if the 
sustain pedal is down.



Chase Events

With this item ticked SWEET SIXTEEN will "look backwards" on every track to detect and transmit the 
nearest Program Change message, Volume message (control change 7), Pan message (control change
10), Reverb message (control change 91) and Chorus message (control change 93).
This ensures that you will always have the right settings for each MIDI channel (instrument).



2 Bar Count In

With this item ticked you will get a two bar count-in.



Simple Bardisplay

With this item ticked, all bar counters will display the position as Bars, Beats and Ticks instead of Bars, 
Beats, Groove and Ticks.



Show Real Time Clock

With this item ticked, a clock will be displayed in the Control Box. This will display the current time of 
your song. 



Allow Double Clicks

With this item ticked, you may double click a value and enter the desired value with the computer 
keyboard.
When this feature is enabled, the mouse response for single clicks will be slightly slower. This is because 
the program has to distinguish between single and double clicks. If you don't need this feature, untick this 
item and you'll get faster mouse response.
This feature is not available in the dialog boxes.





Extra Menu

The Extra menu holds additional functions for manipulating events on a track.

Check Track

Check note Overlap

Change Note Length

Freeze Quantize

Freeze Trackparameters

Mixdown 24 Tracks

Remix Track by Channel

Remix Track by Note Number

Insert/Delete Measures



Check Track
This function "cleans up" the current track in the following ways:
1. Inserts missing Note Offs.
2. Deletes Note Offs that don't belong to any Note On.
3. Deletes duplicated events.
Use this function when a track does not sound as it should, for instance after a Cycle Recording.

Keycommand [X].



Check Note Overlap
If your synthesizer is running short of voices, use this function to prevent notes from overlapping. The 
function recognise chords but in order to recognise chords on a unquantized track, quantize the track 
temporarily.

Keycommand [O].



Change Note Length
This function will change the length of the notes on the current track. You are able to:
1. ADD OR SUBTRACT A VALUE
2. STATE A MINIMUM LENGTH
3. STATE A MAXIMUM LENGTH
4. INSERT A FIXED VALUE
5. LIMIT THE CHANGE TO A SECTION OF A TRACK.

Keycommand [Shift] + [L].



Freeze Quantize
Sometimes you may need to "freeze" your quantization. If you have quantized different sections of track 
to different values (with "Modify Track" or note by note in an editor), a dequantization will destroy your 
work. The 'Freeze' function "fixes" your quantization into the events and makes it impossible to return to 
their original value.
Another use is when using the "Swing Factor" in "Quantize Settings". If the notes are played rather 
sloppily you must first quantize without any "swing", then "freeze" the quantize value and quantize again, 
this time with your desired "swing factor".

Keycommand [F].



Freeze Trackparameters
This function transforms the track parameter settings to the events in a track.

If say on the Main Screen, you have transposed one or more tracks, changed velocity values of any or all 
of the tracks, these changes only affect the playback sound and are not embedded permanently into the 
track.
By using Freeze Trackparameters your changes will permanently alter the track events in the current 
Track.
The Main Screen parameter values will be reset to zero and you will now be able to see the result in the 
editors. The music will of course sound no different to before 'Freezing'.

Keycommand [Shift] + [F].



Mixdown 24 Tracks
This function merges all tracks in a pattern into one track (FORMAT 0).

Keycommand [Shift] + [M].



Remix Track by Channel
This function extracts events according to their MIDI channels and moves them to separate tracks, one 
for each MIDI channel (FORMAT 1).

Keycommand [Shift] + [R].



Remix Track by Note Number
This function extracts notes according to their pitch (note number) and moves them to separate tracks, 
one for each pitch.

Keycommand [R].



Insert / Delete Measures
Regarding these two functions, you can choose to work on one or all tracks in a pattern.

Insert Measures
Insert Measures inserts blank bars between the left and right locators. Events at the right locator position 
and after are moved further to the right to accommodate the new bar(s).
Keycommand [Shift] + [I].

Delete Measures
Delete Measures erases all events between the locators and moves all events lying beyond the right 
locator to the left locator position.
Keycommand [Shift] + [D].

It is also possible to use "Insert Measures" and "Delete Measures" inside the Tempo Track and Time 
Signature Track editors. This will affect those tracks only.



The Options Menu

Overall Setting

MIDI / Memory Setup

Quantize Settings

Internal Recording

Full Volume

Synchronization

Note Pad

Default Window Size

Zoom Program



Overall Settings
With Overall Settings in the "Options" menu, Keycommand [V], you can change settings that will affect the
program globally.

Input Filter

Disable Transpose

MIDI Click

MIDI Thru Off Channel

Remap Controller

Swap Mouse buttons



Input Filter

Here you can filter out MIDI messages that you don't want recorded or sent out via MIDI Thru. If your 
synthesizer does not respond to aftertouch (channel and polyphonic pressure) it makes sense to filter 
them out.
Some synthesizers (e.g. Roland) send out an All Note Off message every time you stop playing a key. 
Filter it out by choosing All Note Off in the bottom of the Input Filter Box.



Disable Transpose

Here you can disable the arrange list transpose function on the MIDI channels you use for drum 
sounds.



MIDI Click

Here you choose:

1. MIDI output port, A or B.
2. MIDI channel.
3. Note number.
4. Velocity for the metronome click.



MIDI Thru Off Channel

If your synthesizer does not have a Local On/Off function, you may disable the MIDI Thru function on a 
chosen channel.



Remap Controller

Here you may choose to remap an incoming control message to a different one. With Control 7 (Volume)
you can perform a tasteful fade-out of your music. If your synthesizer does not send out this Control 
Number, re-map the Modulation Wheel (Control 1) to Volume and you have a nice real time mixer function
(if in Record Mode it will be recorded). Click on the "Remap" icon to activate.



Swap Mouse buttons

Normally a click on the left mouse button will increase the value but by 'clicking' on the word "Right Button
Increases" this will change and the right button now increases and the left button decreases.



MIDI / Memory Setup

MIDI Setup
Here you select which MIDI in and MIDI out ports you want use by using the drop-down lists (combo 
boxes). All the MIDI ports that are available on your system will appear in the list boxes along with a "No 
device" choice. The Output port lists should also have an option for the MIDI Mapper. See your 
Multimedia Extensions documentation for details on using the MIDI Mapper.

To make a port selection, click on the arrow button to the right of the combo box and a list of all available 
selections will appear. Click on the selection that you want. The "No device" choice is useful for freeing up
a port so that it can be used by another application.

General MIDI Sound Set
When using the Mixer you can choose to see the program settings either as a number or as an 
instrument name.

Select the MIDI channels, by using the drop-down lists, where you want the instrument names to be 
shown. The instrument names are General MIDI Setup names and can not be changed.

Memory Setup
Since Windows is a multitasking environment you also have to decide how much memory SWEET 
SIXTEEN will utilise. The less amount you allocate, the more there will be left for other applications you 
may want to run simultaneously.

Also you may choose the number of MIDI events needed. If you at any time are running out of memory 
you will have to increase the number of MIDI events, save your work and restart SWEET SIXTEEN. Try to
avoid allocating more memory than you really need since this will slow down the overall performance of 
your system (Windows).

Timer Resolution
The Timer Resolution Setting determines how fast a timer interrupt SWEET SIXTEEN uses. The smaller 
the setting, the faster the interrupt rate. The range possible is between 1 and 20. Normally you don't have 
to change this setting. But if your computer is a slow 386 and the timing of the music is not tight, you may 
select a setting greater than 10. If your computer is a fast 486 or higher, you may select a setting less 
than 5. Faster interrupt rates will cause the computer to do more work, and therefor screen updates etc. 
might become slower. This is also true if you run other programs at the same time. 



Quantize Settings
In the "Options" menu you will find "Quantize Settings" where you can choose different ways of 
quantizing. The settings you make here are global settings which affect all parts of the program where 
quantizing is possible. Changing a setting does not change recordings already made.

Quantize
Quantize means that MIDI events are moved to a new position determined by the divisions of the beat 
and time signature. The Quantize value denotes how many parts a 4/4 bar can be split up into. When 
quantizing, the events are moved to the closest beat.

With the value 8 the events will be moved to the closest 1/8 note, value 12 to the closest 1/8 note triplet, 
value 16, to the closest 1/16 note etc. In SWEET SIXTEEN only the note positions are affected and do 
not affect the actual sound of the music. The length of the notes will remain unaltered.

Tight Quantize
The notes will be moved exactly to the closest beat.

Smart Quantize
With this enabled, you can effect polyrhythmic quantization. Quantize value 16 will quantize to 1/16 and 
1/8 triplets (16/12), value 12 to 1/8 triplets (12/8) etc. "Smart Quantize" also analyses the timing 
characteristics of the music and quantizes the notes correctly even if the music is played behind or ahead 
of the beat.

Quantize Strength
The value determines how much a note will be moved expressed as a percentage. 100% will move the 
note all the way to closest quantization step, 50% half the way and 10% a very small amount. This way 
you can "tighten up" your music by varying amounts to keep a human feel.

Swing Factor
Another way to keep the human feel is to add some "swing" to the music while quantizing. The 
settings here are -90% to 100%. Straight "grooves" like 8,16 etc. will, with a positive setting, approach 
12,24 "grooves".

In notes, will approach 

.

 "Grooves" that already have a "swing feel" (12,24) will, with a negative setting, be more straight 
(approach 8,16 etc.)



Internal Recording
In the Options menu you'll find 'Internal Recording'. With this activated SWEET SIXTEEN will record all 
MIDI events that are sent out via MIDI Out. Choose channel A1-A16 or B1-B16.

An explanation: When saving MIDI files, only the current pattern is saved. If you have a song spread out 
over several patterns and arrange positions (and you most probably have), it would be nice to have all 
your song in One Single Pattern. To enable you to do this, use Internal Recording. The way of doing this
is as follows:

Activate 'Internal Recording' by 'Clicking' on the icon, choose an empty track in pattern 17 and start 
recording. All MIDI events will now be recorded into this track. When the recording is finished you can use
the Remix Track function to separate the MIDI channels to individual tracks. Pattern 17 now contains the 
whole song and you can save this as a MIDI File. If you use port B (channel B1-B16), activate 'Internal 
Recording' for these channels and repeat the procedure. This is a lot quicker than cutting, pasting and 
copying the music. It also automatically "freezes" the track parameters like loop, transpose etc. These 
will normally not be saved to a MIDI file since they are playback parameters.



Full Volume

Sends out a full volume message (controller 7) on all MIDI channels.



Synchronization

Lets you choose between Internal Sync (SWEET SIXTEEN is the master) and External Sync (SWEET 
SIXTEEN is slaved to an external device that outputs MIDI Clock events).



Note Pad

Here you can make notes about your song. The notepad is saved together with your song.
NOTE: Note Pad information is NOT saved when your work is saved as a Midifile.



Default Window Size

If you have changed the size of the main window this functions resizes the window to its default size.



Zoom Program

You may run Sweet Sixteen in any screen resolution. Sweet Sixteen automatically resizes itself to cover 
the whole screen when you first install it. If you run in one of the bigger resolutions, you may latter resize 
Sweet Sixteen. This setting is saved when closing Sweet Sixteen.

Sweet Sixteen automatically resizes itself according to the following screen 
resolutions:
1. 640 * 480 pixels
2. 800 * 600 pixels
3. 1024 * 768 pixels
4. 1152 * 864 pixels
5. 1280 * 1024 pixels
6. 1600 * 1200 pixels 



The File Menu

File handling

Save Song

Load Song

Save MIDI File

Load MIDI File

Save Pattern

Save Track

Load Pattern / Load Track

In the File menu you'll also find more functions

Clear Song

About

Quit

Additional info

File Name

Standard MIDI Files (SMF's)

Auto Load



Save Song

The usual way to save your work (In most cases) is called 'SAVE SONG'. This saves the entire content of 
the program i.e. ALL TRACKS IN ALL PATTERNS, THE ARRANGE LIST AND ALL GLOBAL SETTINGS.
Keycommand [Ctrl] + [S].



Load Song

With Load Song everything is loaded back into the program and the old song is erased.
Keycommand [Ctrl] + [O].



Save MIDI File

This command lets you save the current pattern as a Standard MIDI File. 
If the pattern contains only one track, it will be saved as Format 0, else as Format 1.
To save a whole song containing several patterns as a SMF, see section on Internal Recording.
Keycommand [Ctrl] + [Shift] + [S].



Load MIDI File

This command lets you load a Standard MIDI File  into the current pattern.
Keycommand [Ctrl] + [Shift] + [O].



Save Pattern

Saves the current pattern to disk.



Save Track

Saves the current track to disk.



Load Pattern / Load Track

These are the corresponding functions for getting the data back into the program. These functions allow 
you to use sections of a song in other songs.



File Name

A file name may consists of a name of up to eight characters followed by a three character extension that 
shows the filetype (the extension is added by the program). The possible extensions are: SNG (songfile), 
PAT (pattern file), TRK (track file) and MID (Standard MIDI File).



Standard MIDI Files (SMF's)

These are created to enable the transfer of music between different manufacturers Keyboards and sound 
modules. SMF's have been developed in two main formats known as Format 0, and 1. Format 0 contains 
one track, multiple channels and Format 1 several tracks, each track has its own MIDI Channel.

In SWEET SIXTEEN you may save the current pattern as a SMF. If the pattern contains only one track, it 
will be saved as Format 0, else as Format 1. To save a whole song containing several patterns as a SMF, 
see section on Internal Recording.



Auto Load

By saving a file with the name DEFAULT.SNG, this file will be automatically loaded every time the 
program is booted. This way you can import your favourite settings, e.g. MIDI Click Channel, Input 
Filter, Disable Transpose etc, automatically into the program.
DEFAULT.SNG must be in the same directory as SWEET SIXTEEN.



Clear Song

Clears all data in SWEET SIXTEEN and resets all settings.
Keycommand [Ctrl] + [N].



About

Displays copyright info etc. and the number of free MIDI events.



Quit

Ends the program.
Keycommand [Ctrl] + [Q].





The Edit Menu

Event Editor

Grid Editor

Tempo Track Editor

Signature Track Editor

Select Notes

Additional info

MIDI Events

The Event List

More on Edit



MIDI Events
MIDI (Musical Instrument Digital Interface) is a universal standard that has existed since 1983. It's a 
serial interface, i.e. all events are transferred after each other. Every event consists of at least one 
status byte telling us what type of event it is. Some events have an extra data byte, some have two 
extra data bytes and system exclusive has any number of data bytes.

Since data transferral is serial, when you hit a chord on your keyboard, it's actually a very fast 
arpeggio. This is also the way a computer works. A computer can only do one thing at any given 
moment but it does it extremely fast, so to us it appears as many things happens simultaneously.
 
All the following events have a status byte. This tells us what type of event it is and what channel 
number it has. The channel number is between 1 and 16 and a synthesiser can "listen" to one of 
those channels (Omni Mode Off) or all channels (Omni Mode On).

Note On Events
These have two data bytes. The first data byte is the note number and the second data byte how hard
(fast) it was struck (velocity value).

Note Off Events
These have two data bytes. The first data byte is the note number and the second how fast the key 
was released. Note On with a velocity of zero is also interpreted as Note Off.

Program Change Events
Has one data byte. The data byte holds the program number.

Pitch Wheel Events
Have two data bytes where the first one is seldom used and can be disregarded but the second byte 
holds value between 0 - 127. 64 is no bend, 0 is maximum downward bend and 127 is Maximum 
upward bend.

Channel Aftertouch Events
Have one data byte for the amount.

Poly Aftertouch Events
Have two data bytes, one for the note number and one for the amount. If your keyboard sends 
aftertouch, check if the sound you use responds to it. If not, it is advisable not to record them, i.e. filter
them out (use the Input Filter in Overall Settings).

Controller Events
Have two data bytes. The first indicates the control number and the second, its value.

System Exclusive Events
Has any number of data bytes and end with a special status byte called EOX (End Of Exclusive).

Text Events
Not actually a MIDI event but may appear in MIDI files and is also used by Sweet Sixteen. Has any 
number of data bytes.



The Event List
In any of the edit modes you will see at least one line of numerical values. This is called the event list 
and displays every MIDI events on a track with their exact time position. All the values are editable by 
'clicking' on the event.

The extreme left column displays the time position of the event. If the track is quantized, the effect on 
the time position will be seen here.

The next column shows what type of MIDI event it is.

The next column shows the MIDI channel of the event (if applicable). This Channel indicator is 
overridden by the channel chosen in the Main Screen. I.E. If the chosen channel is Channel 5 but in 
the Main Screen, Track/Channel 5 is changed to say 2, then all notes on Channel five will be heard in 
the Voicepatch chosen for Channel 2. When symbol "--" is displayed on the Main Screen it means 
that:

1. Events are sent out on their correct channel.
2. There may be events on several channels, all on the same track (ie. Format 0).

The next two columns are for the first and second data byte (see explanation in section about MIDI 
Events).

The right most column displays either the length of a note or information on other types of events.



Event Editor
To enter the Event Editor, 'Click' the "Event    button" or press [E]. To the right of the event list you will 
find buttons that control the editor.

The buttons with the "Up/Down Arrows" will move the event list cursor forward or backward in the 
event list. Clicking and holding will give continuous scrolling.

A 'click' on the "Cue button" between the arrows, Keycommand [P], starts the sequencer playback 
from the current cursor position.

To allow editing to take place during playback the display will 'freeze' as soon as you 'click' on an 
event in the display, or 'click' on the arrow buttons. Clicking the "Unlock" button or pressing [U] will 
reactivate the display scrolling.

Display Filter
With the six small buttons above the arrow buttons, events can be hidden from the display. A mouse 
'click' to depress a button indicates that the event type will be visible and a normal button means that 
it will be hidden from view.

"on" = Note on
"off" = Note off
"prg" = Program Change
"ctr" = Control Change
"pw" = Pitch Wheel
"aft" = Aftertouch

Be assured that hidden events are still played back and transmitted over MIDI.

Inserting Events
A 'click' on the "Insert Note" button will insert a note at the current event time position, [Insert].

Clicking the "Insert Other" button will insert a none-note event, [Shift] + [Insert].

Clicking the "Change Event" button will change the status of a none-note event to another none-note 
event. It will also change a "real" note off to a note on with velocity 0 or vice versa.

Clicking the "Delete" button will delete the cursored event, [Delete].

You may also insert and edit System Exclusive and Text events. 'Right click' in the name area of the
current event and a dialogue box is shown. Now alter the new values and press OK. It is not possible 
to alter long messages.



Select Notes
This menu function is active only in the Grid Editor. With this function you may select many notes at 
one time.

The following alternatives are available:
1. All - selects all notes
2. Toggle - selected note(s) is deselected and vice versa
3. Equal Pitch - notes with same pitch as the selected note(s) also becomes selected
4. Lower/Same Pitch - notes with lower and same pitch as the selected note(s) also becomes 
selected
5. Following - all notes following the first selected note also becomes selected



Grid Editor

The Grid
Clicking the "Grid" button, press [G], enters the Grid Editor where you will see the music as a "Piano 
Roll". The notes are displayed as vertical bars on top of a number of horizontal lines. This area is 
called the "grid". The solid lines are bar lines, the bigger dotted lines represents the beat and the 
smaller dotted lines the division of the beat (the groove value).

When the sequencer is running, you will see a horizontal line is moving down the grid. This line 
shows which bar is currently playing.

Above the grid you will see a keyboard. When you move the mouse, a "dot" on the keyboard follows 
the movement of the mouse.

Selecting notes
You may select notes for editing in a number of ways.

1. A 'left click' on a de-selected note, selects this and de-selects all other notes. Holding the [Shift] key
down while selecting, keeps other selected notes selected.
2. You may also select several notes. 'Left click' outside a bar and keep the button down. You may 
now, with the "rubber band", select many notes.
3. You may use the Select Notes item in the Edit Menu.
4. Holding down the [Shift] key while scrolling.

Moving Notes
If you 'left click' on a bar and hold it down, a shadow/ghost beam appears and the mouse pointer 
alters shape to a hand. You have now caught a note and can move it to a new place.

Dragging it up or down will move it backwards or forwards in time (see the bar counter above the 
keyboard to see your precise position). Moving it left or right will transpose it.

When moving notes in the "grid area", the first direction you move in decides whether you are 
changing the position or transposing. Adding the right mouse button or the control key, allows you to 
move in any direction. This saves a lot of double editing when you drag the wrong way by mistake.
 
If you want to move it before or after the bars you see at the moment, move the mouse pointer above 
or below the grid. This will scroll the display. Release the button when you reach the desired position 
and the note will be moved. The same applies for transposing notes.

Copying notes
Adding the [Alt] key copies the selected notes instead of moving them.

Changing note lengths
A 'right click' on the bar will change the mouse pointer into a pointing finger. You may now change the 
length of the note. Adding the [Alt] key, copies this new length to all selected notes.

Deleting notes
It's possible to delete the selected note event(s) in the "grid area" by right clicking on a selected note 
while holding the [Shift] key down. If no note is selected you may delete the cursored event in the 
event line by pressing the [Delete] key.

Inserting notes
A 'right click' on the grid will insert a note with the same velocity and length as the previous note that 



was 'clicked'. This 'insert' can be at any position on the grid so it is possible to insert an entirely 
different note and a new time position.

The use of the mouse/keyboard in the Grid Editor is as follows:
1. Left clicking selects a note and deselects all other.
2. Left clicking while holding down the [Shift] key selects a not selected note or deselects an already 
selected note.
3. Left clicking and holding down the mouse button lets you move the selected note(s) to a new place.
Adding the [Alt] key copies the notes to a new place.
4. Right clicking on a selected note allows you to change the length of it. Adding the [Alt] key, copies 
this new length to all selected notes.
5. Right clicking on a selected note while holding the [Shift] key down will delete the selected note(s).
6. Left clicking on the grid and keeping the button down allows you to select several notes with the 
help of a "rubber band".
7. Right clicking on the grid will insert a note at this position.

Control Display
To the right of the grid is the Control Display. 

By 'clicking' on the name area of the Control Display you may alter what it should display. The default 
value is Note On velocity. Other possibilities are: Pitchbend, Aftertouch, Program Change, and all 
Controller events.

By 'clicking' the line that divides the grid and Control Display Area and moving it left/right, you may 
change the area of the Grid/Display.

The use of the mouse/keyboard in the Control Display is as follows:
1. Left clicking allows you to inspect a desired event.
2. Left clicking while holding down the [Shift] key allows you to alter a desired event. Adding the 
Control key centres the value to 64.
3. Right clicking allows you to insert an event at a desired time position (not note events).
4. Right clicking while holding down the [Shift] key allows you to delete an event (not note events).

When inserting events in the Control Display, the current groove value dictates how close the events 
are inserted.

When displaying controller and pitchbend events in the Control Display, events that has a centre value
(i.e. 64) while be drawn as black beams.

Snap / Zoom
To the right of the Control Display you will see some buttons. Activating the "Snap" button will quantize
the note to the current "groove" value while moving, changing length and inserting.
The "Zoom" values controls the display resolution of the Grid Editor.
The first value indicates the vertical resolution and states how many clock ticks a pixel (points on the 
screen) represents. With a bigger value you will see more bars but it will be difficult for precise 
adjustments, and vice versa.
The second value indicates the horizontal resolution of the piano editor. The value you enter is the 
width of the notes in screen pixels. With a small value you will see many but small notes and with a 
bigger value, few but wide.



MIDI Step Input
In edit mode, it is possible to enter notes from your keyboard step by step. To activate, 'click' on the 
"Step Inp" button.

The bar counter above indicates the time position for the notes to be entered (you can change this at 
any time by clicking and scrolling).

The length will be the same as the "Groove" value.

The counter will be incremented according to the groove value after the key(s) are released.

Pressing [Tab] will insert a pause. Pressing [Tab] while holding down the key(s) will lengthen the 
note(s). The sustain pedal (Controller No. 64) has the same function as pressing [Tab].

In all editors you can change the groove value with [1] - [8] on the typewriter keyboard. This way you 
can easily record "unplayable" runs in no time.

"MIDI Step Input" is automatically disabled when leaving the editor (or clicking the "Step Input" 
button).

Quantization
The cursored/selected event(s) can be quantized to the selected groove value by 'clicking' the "Qua" 
button or pressing [Q]. This allows you to have different quantize resolutions in a track.

Clicking the "Deq" button or pressing [Shift] + [Q] will dequantize the cursored/selected event(s). 
Quantizing will use the settings in menu function "Quantize Settings".

Undo in Edit Mode
The first editing you do will save the current track into the Undo-buffer. Clicking the "Undo" button or 
pressing [Alt] + [Backspace] will toggle between the original and edited track.

Actual Position
If you work in Song Mode and want to see the event time position relative to the start of the arrange 
list, you must tick "Actual Position" in the "Flags" menu. If "Actual Position" is switched off you are 
viewing the events time position relative to the start of the current pattern.

Defining a Left/Right Limit
You can define the left and right limit for part operations by pressing [L] and [R] on a cursored event. 
When entering functions like "Modify Track", the left and right locators will be loaded with these 
values. This way you can easily quantize or transpose just a part of a track.



Tempo Track Editor
If you, at any point, need to change the tempo you will have to activate the "Tempo Track" icon in the 
Main Screen. Click the "Tempo T" icon, Keycommand [T].

To edit the "Tempo Track", choose "Edit Tempo Track" from the Edit menu, Keycommand [Shift] + [T]. 
You can now insert and delete Tempo change events, change the tempo value and position of the 
events.

Any changes in this screen will be valid for the whole song.

Process Tempo Track
In the upper right corner of the "Tempo Track Editor" you will see the "Process" icon. Clicking this 
icon will opens a dialogue box. In the upper area you can enter a percentage value which will 
increment or decrement all tempo events on the "Tempo Track". An easy way to change the tempo of 
a song in one shot.

The lower area has a function that makes it possible to program accelerando and ritardando. Do like 
this: In the Tempo Editor, insert tempo events into the bars in question (click on the "Other" icon or 
press [Shift] + [Insert]). Start with an event on every eighth note (the tempo of the event doesn't 
matter). Enter the "Process Tempo Track" function.

Enter values at "Start Tempo" and "End Tempo" and in the bar counters, enter the start and end 
bars. Click "OK" and listen. If the tempo changes aren't smooth enough, enter more Tempo Events 
between the existing ones and repeat the procedure. 

The values you enter in this editor apply to the whole song, and not to just a single pattern. This also 
means that the position values are actual position values (see the explanation of Actual Position).



Signature Track Editor
If you, at any point, need to change the time signature you will have to activate the "Time Signature 
Track" icons in the Main Screen. Click the "Time S" icon, Keycommand [W].

To edit the "Time Signature Track", choose "Edit Time Signature Track" from the Edit menu, 
Keycommand [Shift] + [W].

Any changes in this screen will be valid for the whole song.

This editor works in the same way as the Event Editor. You can insert and delete values to change 
the time signature and position of the changes (ideal for inserting an occasional 2/4 bar in a mainly 
4/4 song ).

The values you enter in this editor apply to the whole song, and not to just a single pattern. This also 
means that the position values are actual position values (see the explanation of Actual Position).



The Functions Menu

The Functions menu holds a number of functions for copying and processing events on a track.

Copy Track

Copy Pattern

Push Track

Modify Track

Delete / Keep Events

Transform Events

Twelve Tone Techincs



Copy Track
This function displays a dialogue box which let you copy a track to another. If the destination track is 
occupied, the two tracks will be merged. You may also, by choosing "Copy Part" (entering the desired 
positions in the locators) to copy a part of a track to another track. "Extract" will move a part of track to 
another track.
Keycommand [Shift] + [C]



Copy Pattern
This function displays a dialogue box which let you copy a whole pattern to another. The destination 
pattern must be empty.
Keycommand [Shift] + [Y].



Push Track
With this function you may shift the time positions of the events on a track forward or backwards. Enter 
the desired value in the barcounter and choose the direction you require it to be moved.
Keycommand [Shift] + [P].



Modify Track
All the track parameters except delay are represented on the "Modify Track" window. This is where you 
make permanent changes to a track. The changes you can make are as follows:

Channel 1-16 Off/On
Provided the Icon is 'ON', you may change all MIDI events on the current track to the chosen Channel 
Number.

Transpose    -64 to +64    Off/On
Transposes part, or the whole of a track by the chosen amount.

Velocity    -99 to +127    Off/On
Adds or subtracts the chosen value to the existing note velocities on the current track.

Compress    0 to +4    Off/On
Compresses wide variations in velocity values. See section on Track Parameters.

Quantize    NO,4,6,8,12,16,24,32,48 Off/On 
Quantizes to the chosen value.

In all the above cases when the "OFF" is indicated, the function is disabled. Likewise when you 'Click' the 
"ON" icon, this means the function is activated. The main use of this function is when you want to alter 
just part of a track by activating "Part Modify".

For example, you may quantize a part of track, transpose just four bars of a 16 bar track etc.
Keycommand [M].



Delete Events
With this function you determine a number of conditions for the MIDI events you want to delete. You are 
able to specify what type of events will be deleted.

These are: All Events, Note, P-Press, Control, Program, C-Press, Pitch wheel and SysEx. You may also 
choose on which MIDI channel(s) to work on, e.g. 3-3 means only channel 3. 4-7 means 4 to 7 inc.

Also between which notes, (e.g. C2 - D3). Not least of all, between specified velocity ranges. If the MIDI 
events you want to delete are notes, you may in the Note Length box, specify to delete only notes that are
longer or shorter than a given value. Click on the text above the digits to choose the condition. You may 
also limit the processing to a specified section of the track by activating "Part Delete". Events that do not 
match the conditions will be left untouched.

Example: You have recorded a Piano track on channel 3 with both the left and the right hand. You now 
want to remove the left hand (Bass notes). Enter "Edit Mode" and you find that the highest bass note is 
C3. Enter the "Delete Event" function and set up these conditions:

You have now chosen all notes between C-2 and C3 of MIDI channel 3. Click "OK" and the notes are 
deleted. Clicking "DO IT" carries out the command but the window stays on the screen for further editing.

Keep Events
"Keep Events" works as "Delete Events" except that the conditions states what should be left on the track.
Keycommand [K].



Transform Events
With this function you may process and transform events in a number of ways. As in "Delete/Keep 
Events", you determine a number of conditions for the MIDI events you want to change. Keycommand 
[H]. In the bottom of the window you'll see a smaller box titled "Result". The MIDI events chosen will here 
be transformed according to the dialogue in this box.

First you select what type of MIDI events you want to transform. Then select which MIDI channel(s) you 
want to process, box -1- indicates the actual notes and box -2- the velocity.

The lower boxes have the title "Process Result". Here you may specify the results from column -1- and -
2-. A plus sign means you will add the value to the result, a minus sign that you will subtract the value and
a percentage sign means you will make a percentage change. 100 % will leave the result unaffected, a 
value less than 100% will decrease the result and a more than 100% will increase the result. 130% is 
equal to a multiplication by 1.3 and 50% is a multiplication by 0.5.

Example: You have imported a MIDFILE from a friend. Your synthesizer is a ROLAND JV-80 and your 
friend has another make of keyboard. The drums will probably sound different. What you need is to 
change the note numbers on the drum tracks. Say your friends Bassdrum is A0 and the drum channel is 
say channel 5. Your JV-80 (and all GM/GS sound sources) drums are on channel 10 and a Bassdrum is 
C1. Enter "Transform Events" and make up the conditions like this:

EVENT = NOTE
CHANNEL = 5 - 5
-1- = A0 - A0
-2- = 1 - 127

You have now chosen all A0 notes on MIDI channel 5 no matter the velocity value. In the "Result Box" 
enter the following values:

EVENT = NOTE
CHANNEL = 10
-1- = -1-
-2- = -2-

In the "Process Result Box":

-1- = +3
-2- = 0

You have now chosen all A0 notes on MIDI channel 5 and you have told SWEET SIXTEEN to add 3 semi-
tones to note A0 and to change the MIDI channel to channel 10.



Twelve Tone Technics
This function actually consists of two functions often used by modern composers.

Mirror Pitches

Reverse Pitches



Mirror Pitches
This function will mirror all notes on a track around a desired centre note.

Example: Say you have a melody consisting of the notes C1 D1 F1 G#1. If you chose D as the centre 
note, this line will be converted to E1 D1 B0 G#0. 

You may exclude notes on a desired MIDI channel. This way you may convert a track containing a whole 
song without affecting the drumsounds (which often are MIDI channel 10).



Reverse Pitches
This function will reverse all pitches on a track. The first note will get the pitch from the last note and so 
on.
The time position of the events are not affected.

This way you may easily create new interesting melodies from the material you already have.





The Mixer

The Mixer allows you to generate, transmit, record or display certain kinds of MIDI events. 
Volume message (control change 7), Pan message (control change 10), Reverb message 
(control change 91), Chorus message (control change 93), Program Change message and Bank 
Select message. All have their own controls in the Mixer.

The Mixer contains 16 channels, one for each MIDI channel. Each channel contains a number of 
controls. To transmit MIDI data, 'click' on a control (for the Volume control, move the mouse up or
down, for the Pan control, move the mouse up/down or left/right). In record mode, the data 
generated by the controls will be recorded to the current track. Remember that the numbers 1-16 
correspond to MIDI channels 1-16, not track numbers!

When recording mixer movements which contains more than one MIDI channel, you must set the
track's channel to -- (no re-channelization) so the same channels are played back. If only one 
MIDI channel is recorded the track's channel can be assigned to that channel or left at --.

Try to keep the data recorded from the Mixer separated to it's own track. It's of course possible to
keep the data from the Mixer on the same track as any other MIDI data. In Song Mode you may 
use a track(s) in Pattern 17 which run in parallel to the other patterns.

If you are not satisfied with your recording using the Mixer, then use the Undo function. You can 
also delete data on certain MIDI channels with menu item 'Delete Events'.

Since SWEET SIXTEEN is able to send the MIDI data to two different ports (A and B), the Mixer 
also has    settings for ports (A or B). The data generated will be recorded to the current track 
which means you can not record MIDI data for port B to a track that is assigned to port A or vice 
versa.

Holding down the alternate key on the computer keyboard while moving a Volume control will 
move all Volume controls at the same time.
Holding down the control key on the computer keyboard will set the control of the selected 
channel to it's default position (not Program).



You may define the "Volume Fader Button" to any controller message by clicking the 
"Define..." button in the Mixer Screen. The default value is Volume/control 7.

You may group several Volume faders by 'clicking' the buttons labelled "Grp" (group) below the 
Volume faders (the colour of the box becomes inverted). Moving one of the faders in the group 
will move the whole group. If a fader reaches it's upper or lower limit before the others, it will 
remember its off-screen value, so the relative mix between the faders stays the same. Holding 
down the shiftkey on the computer keyboard allows you to move a Volume control within a group 
without affecting the others.

The "Solo" button is used to solo a desired MIDI channel (not a specific track). Clicking a button 
while holding down the Control key makes it possible to "solo" several MIDI channels at the same
time.

The "Mute" button which will mute one or more MIDI channels (not specific tracks).

You can choose to see the "program settings" either as a number or as an instrument name.
With General MIDI Sound Set in the MIDI / Memory Setup dialogue box you may select the 
MIDI channels where you want the instrument names to be shown. The instrument names are 
General MIDI Setup names and cannot be changed.

"Bank Select numbers" are displayed above the Program Change numbers.
A Bank Select message actually consists of two control events (Control 0 and control 32) plus a 
Program Change message. A synth does not select a new bank until it has received all three 
(Sweet Sixteen handles this automatically).

The formula for a bank number is: The value of Control 0 times 128 plus the value of Control 32.

Example:
Control 0 Value 16 16 * 128 = 2048
Control 32 Value 2
The sum of these two numbers are 2050.

Note: Roland synthesizers do not respond to Bank Select messages according to the MIDI 1.0 
Specification. Roland uses only Control 0, which means that if your Roland manual states that 
the user memory responds to Bank number 80 you must enter 10240 in the Bank Select number 
box in the Mixer.
Control 0 value 80 times 128 = 10240. Control 32 has no meaning for those synths so actually 
any number between 10240 and 10367 will do.

In addition to sending data via MIDI Out, the mixer also responds to data arriving at MIDI In and 
to data contained within a song. The controls move in response to the same messages they are 
capable of sending, so the Volume faders move in response to MIDI Volume data and so on.

Menu item 'Chase Events' which sends the current values of controllers and program via MIDI, 
also updates the positions of the mixer controls.

The input filter settings in 'Overall Settings' will also affect what is recorded from the Mixer. 
Check that program and control changes are not filtered out.



You may store four different Mixer settings or Snapshots (1 to 4) by 'clicking' on the "Store" 
button. These will be saved with your song. If you 'click' on the "Recall" button one of the four 
Snapshots will be recalled and sent via MIDI. If you are recording, these settings will be also 
recorded. This means a 'Snapshot' of the current setting can be recorded. This    is a good way of
storing the Volumes and Pans etc. of a song once you have set them up.
Remember! If you do not record your settings to a track, you must store them as a Snapshot. 
Else they woll not be saved with your song!
 



Key Commands
Main Screen

Edit Screen



Main Screen

[A]

[B]

[C]

[Shift] + [C]

[D]

[Shift] + [D]

[E]

[F]

[Shift] + [F]

[G]

[H]

[I]

[Shift] + [I]

[K]

[Shift] + [L]

[M]

[Shift] + [M]

[N]

[Shift] + [N]

[O]

[Ctrl] + [O]

[Ctrl] + [Shift] + [O]

[P]

[Shift] + [P]

[R]

[Shift] + [R]

[S]

Song/Pattern Mode

Erase Previous Overdub (Cycle Record)

Cycle Mode On/Off

Copy Track

Delete Events

Delete Measures

Event Editor

Freeze Quantize

Freeze Track Parameters

Grid Editor

Transform Events

Internal Recording

Insert Measures

Keep Events

Change Note Length

Modify Track

Mixdown 24 Tracks

Name Pattern

Note Pad Window

Check Note Overlap

Load Song

Load MIDI File

Auto-Punch On/Off

Push Track

Remix by Note Number

Remix by MIDI Channel

Solo Track



[Shift] + [S]

[Ctrl] + [S]

[Ctrl] + [Shift] + [S]

[T]

[Shift] + [T]

[Shift] + [U]

[V]

[W]

[Shift] + [W]

[X]

[Shift] + [Y]

[0]..[9] and
[Shift] + [1]..[7] (Alfa)

[F1]..[F4]

[Shift] + [F1]..[F4]

[F5]..[F8]

[Shift] + [F5]..[F8]

[Esq]

[Delete]

[Insert]

[F12]

[Alt] + [Backspace]

[Up/Down Arrow]

[Shift] + [Up/Down Arrow]

[ * ] (Num)

[ / ] (Num)

[ + ] / [ - ] (Num)

[Enter]

[ . ] (Num)

MIDI / Memory Setup

Save Song

Save MIDI File

Tempo Track On/Off

Edit Tempo Track

Quantize Settings

Overall Settings

Time Signature Track On/Off

Edit Time Signature Track

Check Track

Copy Pattern

Pattern Select

Recall Barcounter Position

Store Barcounter Position

Recall Locator Position

Store Locator Position

Name Track

Delete Current Arrange Entry

Insert New Arrange Entry

All Notes Off, Reset Controllers

Undo previous track change

Select Track

Change Arrange Position

Replace Record

Overdub Record

Increase/Decrease barcounter position

Stop

Pause/Continue



[ 0 ] (Num)

[Backspace]

[Spacebar]

Start

Erase Current Track

Drop In/Out of Recording



Edit Screen

Key commands for pattern and arrangelist disappears

[L]

[P]

[Q]

[Shift] + [Q]

[R]

[U]

[ 1 ] + [ 8 ] (Apha)

[Delete]

[Insert]

[Shift] + [Insert]

[Up/Down Arrow]

[Left/Right Arrow]

Cursored event position copied to left locator

Start playing from cursored event

Quantize selected event

Dequantize selected event

Cursored event position copied to right locator 

Unlock - reactivate display scrolling

Select groove value

Delete cursored/selected event

Insert note event into event list

Insert non-note event into event list

Scroll event list up/down

Horizontal Grid scroll



How to order
To get the full version of Sweet Sixteen, use the order form below.

Name:  

Street:  

City:  

Country:

Sweet Sixteen (full version) ($30 US) $ ________ 

Printed manual / program disk ($10 US) $ ________ 

Delivered by e-mail (No extra) $ 0.00____

Shipping and handling ($5 US) $ ________

Cash Payment (No extra) $ 0.00_____

Cheque payment (cost for clearing the cheque) ($10 US) $ ________

Total: $ ________

The order should be sent to:

Roni Music
Nybogatan 21
S-212 32    Malmoe
Sweden

or by e-mail: roni@mbox317.swipnet.se

Roni Music Homepage is located at URL:    http://home1.swipnet.se/~w-11396

Because of the small amount of money involved, we advice you to send the payment as cash.
It saves you the money for buying the check. No personal checks, please.

© Copyright 1992-97 Roni Music - All Rights Reserved.




